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Materials herein pertain to the following fields: 

-PC Instructor  -Systems Engineer 
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本教材は自己学習用としてご活用ください。 

各タスクに提出課題がありますが、提出する必要はありません。 

 

Please use this material for self-study. 

There are assignments for each task, but you do not need to submit them. 
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Special Note:  For future Japan Overseas Cooperation Volunteers (JOCV   

      volunteers) or Japan International Cooperation Agency Volunteers  

     (JICA volunteers), DO NOT COPY this webpage and give the copy to  

         the training center instructors.  

 

     Read the “What you need to do…” sections and follow the   

     instructions. Give your work product to the Language Section Staff or 

     to your instructors for them to check and return to you. 
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Welcome to the Computer Engineering Training Program. You are about to take part in an intensive 

training program the objective of which is to prepare you to become a self-sufficient and fully functional 

JOCV volunteer. The program will prepare you to perform your host country JOCV assignment to your 

fullest. 

 

The Program is intensive. You will only have about 70 hours of class time to acquire the language and 

teaching skills to enable you to meet the above objective. To be a competent teacher, you will need to 

focus on the tasks you will be given and do your best to accomplish each of them. 

 

How much you will learn and how well you will be able to perform will be up to you. Your instructors 

will guide you, they will give advice and they will help you in any way they can, but you must make the 

effort to learn and use what you have learned. 

 

You will find tasks that you must do below. Each of them plays an important part in the Program. You 

do not have to do each of them perfectly, but you are expected to do each of them to the best of your 

ability. 

 

A schedule for the completion of the tasks is below: 

 

 Task 1  Complete the questionnaire and send it to the training center by the postal service 

before you arrive at your training center. 

 Task 2  Study the vocabulary related to your assignment and fill-in the self-study sheets 

before you enter the Center. Give the results to the Language Section Staff 

when you arrive at the Center. 

Task 3             Make the lesson plan following the instructions and give the results to the 

Language Section Staff when you arrive at the Center. Write the plan the 

same way you would for a lesson you will give in your host country. 

 Task 4  Read the orientation material before you arrive at the Center. The information in 

    it will be important for you to understand. The information will serve as  

    the basis for your training. 

 Task 5  Prepare the 3-minute speech before you arrive at the Center. It will be given in  

    your first Program class. Be sure to check the relevant information and  

    practice your speech. 

 

Detailed information on each of the tasks follows. Good luck and, once again, welcome to the Computer 

Engineering Training Program. 

 

Jackie Newport, Jr. 
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Task 1- Computer Engineer Trainee Questionnaire 

 

Purpose: To give your instructor basic information about your background and expectations you  

  have for your training. 

 

 

What you need to do: Fill-in the questionnaire and send it to your training center  

    before you arrive. 
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Computer Engineer Trainee Questionnaire     

Please give complete and detailed answers in English to the following questions: 

 

1) What is your name and what would you like to be called in your classes? 

 

 

2) What was your pre-JOCV job? (If you were a student, what did you study?) 

 

 

 

3) Have you ever taught before? If yes, please give details such as how long, what level and so on. 

 

 

 

 

 

4) Have you ever been abroad? If yes, please give details such as where, how long, why you went, etc. 

 

 

 
5) Have you ever spoken to foreigners before you entered JOCV? If yes, please give details. 

 

 

 

 

 
6) What is your JOCV host country and what is your assignment there? Please give details. 

 

 

 

 

 

 

7)    What are any problems you think you will have doing your assignment? Please give details. 

 

 

 

 
 

8)    What do you want to learn in your technical class? Please explain your answer. 
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Task 2- Technical content and specific purpose language related to specific assignments 

 

Purpose: In your host countries it is generally assumed that a computer engineer knows and can  

  explain basic topics. Please review the general technical English and contents related to  

  topics in your field of specialization.  

 

 

What you need to do: Complete Part 1 and complete the part related to your JOCV 

 host country assignment. Give the completed parts of the 

 Language Section Staff or to your instructor after you arrive at 

 the Center. 
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Part 1- General Computer Vocabulary 
Following are questions to ensure that all JOCV candidates have the same basic general knowledge of 

computer related vocabulary in English. Answer each question to the best of your ability and go over the 

answers as a class. 

1) What is a computer OS and how is it used? 

 

 

2) What is a machine code and how is it different from an OS? 

 

 

3) How is a command that a person can understand changed to machine code that a computer can 

understand? 

 

 

4) What is the difference between a desktop computer, a laptop computer, a tablet, and a Chromebook? 

 

 

 

5) What are the names of the general parts of a computer and what do they do? 

 

 

 

 

 

6) What is the difference between a GUI and a command line? 

 

 

 

7)  What does FTP mean? 

 

 

 

8) What is a folder? 

 

 

 

9) What is a default setting? 

 

 

 

10) What does configure mean? 
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11) What does BIOS mean? 

 

 

 

12) What does compatibility mean? 

 

 

 

13) What is utility software? 

 

 

 

14) What does plug and play mean? 

 

 

 

15) What does application software mean? 

 

 

 

16) What is the difference between software and hardware? 

 

 

 

17) What does computer protocol mean? 

 

 

 

18) What does archive mean? 

 

 

 

19) What is the difference between to import data and to download data? 

 

 

 

20) What is the difference between update and upgrade? 
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21) What part of Windows 10 does the above set of icons come from? 

 

 

 

22) What icon will you click on to change settings for “Power and Sleep?” Why might you want to 

change the default setting? 

 

 

 

23) What icon will you click on to find what application software is being used on your computer? Why 

might you want to do this? 

 

 

 

24) What icon will you click on to protect the privacy of what you are doing/searching on your 

computer? 
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Part 2- Personal Computer Instructor 
Following are questions to ensure that JOCV PC instructors have general knowledge of how to teach 

computer related information with regards to productivity software in English. Answer each question to 

the best of your ability and go over the answers as a class. The material covers Windows Word, 

Windows Excel, and Windows PowerPoint, the most widely used productivity software. The version  

used is Microsoft Office 365 because it is likely to common version used in JOCV host country 

situations in the future. An alternative freeware version is called “OpenOffice.” It is very similar to 

Microsoft Office software applications. 
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Word Processing Software- Microsoft Word 
Look at the view screen for Microsoft Word 365 and answer the questions that follow: 

 
 

1) What is “A” called? What is it used for? 

 

2) What is “B” called? What is it used for? 

 

3) What is “C” called? What is it used for? 

A 

B 

C 
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4) How do you start Microsoft Word? 

 

 

 

5) I have started to insert text, but I made a typing mistake. What should I do? 

 

 

 

 

6) I don’t like the style or size of the text I am using. What should I do? 

 

 

 

 

 

7) I don’t like the color of the text. How can I change it? 

 

 

 

8) I want to insert some shapes into my Microsoft Word document. How can I do it? 

 

 

 

 

 

9) I want to make my document look really good. I want to insert a picture in it. How can I do it? 

 

 

 

 

 

10) I have finished making my document. I want to save it. How can I do it? 

 

 

 

 

11) My English is not so good. Can Microsoft Word check what I wrote? If yes, how can I do it? 

 

 

 

12) I want to open a document that I already wrote. How can I do it using Word? 

 

 

 

13) Can I add an audio or visual file to my Microsoft Word document? If yes, how can I do it? 
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Spreadsheet Software- Microsoft Excel 
Look at the view screen for Microsoft Excel 365 and answer the questions that follow: 

 
1) What is A called? What is it used for? 

 

 

2) What is B called? What is it used for? 

 

 

3) What is C called? What is it used for? 

 

A B 

C 
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4) What is a spreadsheet and how is it different from a document? 

 

 

 

 

5) What is the difference between a “cell” and an “active cell” in Microsoft Excel? 

 

 

 

6) How do you tell the location (address) of a Microsoft Excel cell? 

 

 

 

7) What is the difference between a Microsoft Excel column and a row?  

 

 

 

 

8) When I type data into a Microsoft Excel cell, it is sometimes too long so I cannot see it all. What can 

I do? 

 

 

 

9) When I type data into a cell, Microsoft Excel tries to finish my typing into the cell, but I do not want 

the Excel data it is trying to input. Why is it trying to do this? 

 

 

 

10) What is “AutoFill” and how can I use it? 

 

 

 

11) When I use Microsoft Excel, I find that it always aligns text to the left side of the column and 

numbers to the right side. How can I change this? 

 

 

 

12) How can I add a column or a row to my Microsoft Excel spreadsheet? 

 

 

 

 

13) How can I add a worksheet to my Microsoft Excel workbook? 
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Microsoft PowerPoint 
Look at the view screen for a blank Microsoft PowerPoint 365 slide and answer the questions that 

follow: 

 
 
1) What is “A” called? What is it used for? 

 

 

 

2) What is “B” called? What is it used for? 

 

 

 

3) What is “C” called? How is it different from “D? 

 

 

A 

B 
C 

D 
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4) How can I create a Microsoft PowerPoint slide? 

 

 

 

 

5) How can I add text to my Microsoft PowerPoint slide? 

 

 

 

6) How can I edit text I already put into the slide? 

 

 

 

7)) I want to add a new slide to my presentation. How can I do it? 

 

 

 

8) I don’t like the arrangement of my slides. How can I change it? 

 

 

 

9) In the Ribbon, what does the “Transitions” tab mean? 

 

 

 

10) How can I use the Transitions tab? 

 

 

 

11) In the Ribbon, what does the “Slide Show” tab mean? 

 

 

12) How can I use the Slide Show tab? 

 

 

 

 

13) Can I insert audio/visual media into my presentation? 
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Part 3- System Engineer 
Following are questions to ensure that JOCV system engineers have general knowledge of how to teach 

computer related information with regards to productivity software in English. Answer each question to 

the best of your ability and go over the answers as a class. 

1) What is the difference between a system engineer and a network engineer? 

 

 

2) What is the difference between a LAN and a WAN? 

 

 

3) What is a client computer? 

 

 

4) What is a server? 

 

 

5) What is the difference between a router and a hub? 

 

 

 

6) Name the different kinds of ethernet cables and their capabilities. Which is the best to use? 

 

 

 

7) What is the difference between shielded and non-shielded ethernet cables? 

 

 

 

8) What does “future proof” mean? 

 

 

 

9) What is an AUP? 

 

 

 

10) What is the easiest way to make sure your computer is secure? 

 

 

 

11) What is a firewall? 

 

 

 

12) What is firmware? 
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13) What is Wi-Fi? 

 

 

  

14) What is employee monitoring software? 

 

 

 

15) What is a VPN and how is it used? 
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Systems Engineers- A Special Project 
As a system engineer, you will be expected to know how to design, manage and maintain a computer 

network. To help you practice, the following exercise was created.  

 

Your objective- 

To create a fully integrated plan that an organization can use for its information technology (IT) 

infrastructure. 

 

The situation-  

The organization has two buildings and fifty-four workers. The buildings are one hundred meters apart. 

Electricity is not always stable in the country. Sometimes there are blackouts. There is a new Internet 

line, and it can provide 100 Mbps of stable connections. Cellular service is poor due to weather related 

problems (floods damaging cell towers, people stealing antennas, etc.). 

 

The organization is on a separate campus with two main buildings. The first building has one large room 

with twenty-two workstations and two more rooms- one is a video-conference room, and the other is a 

meeting room. All of the rooms only have a telephone land line connecting them to each other and to the 

outside.  

 

The second building has three floors with six rooms on each floor. Each room has a workstation but, like 

the other building, there is only a telephone landline connecting each of them and to the outside. 

 

Sometimes visitors come to the organization. They have their own laptops, and they want to be able to 

contact their home offices/organizations, but they cannot do it now. Your plan also needs to think about 

them. 

 

Your task-  
The organization wants to become digital. It wants to connect to the Internet and be able to do online 

meetings. It wants to allow visitors to make contact with the outside via their PCs. It wants to change all 

of its paper-type work into digital form.  

 

You are to make a plan for everything the organization will need to reach its objective of becoming 

digital. The plan will include the necessary hardware and software, network design, training of 

personnel and long-term care (network administration). Be as clear and specific as possible. For 

example, what kind of computers should workers use? Tell the name, model, and specifications. Tell 

what kinds of software will be best and how it can be used.  

 

Also tell why you think your choices are the best. Do the same for everything. 

 

Do not worry about the cost. The organization will get a grant to cover it, but remember it is a JOCV 

host country organization so the cost must not be sky-high. 

  

Write your plans and submit to your instructor. Then make a short presentation (around 15 minutes) 

explaining what you have decided. Be able to explain and to defend your ideas. 

 

Good luck! 
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Task 3- Make a presentation plan 
 

Purpose: You will have a very limited amount of time to not only improve your English language  

  skills, but also learn and use appropriate vocabulary and skills. Your sample presentation 

  plan will help your technical class instructor prepare appropriate activities to directly help 

  you remedy any mistakes or problems you may have. 

 

 

What you need to do: Look at your assignment data sheet. You can use one of your  

    future assignment tasks to make a model lesson. You can use  

    the following lesson plan made by a trainee as an example. You 

    can then use the template that follows to help you to organize  

    your plan. Don’t worry if you can’t do it well. Just try to do  

    your best! Give the completed plan to your instructor after you  

    arrive at the Center. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



3/2022 

 

Lesson Plan Number 6 

Presenter Name: Koichiro Hara    Topic: Word (Advanced) 

Lesson Target Time: 50min.     Lesson Date: Oct 15 

Lesson Audience Level: Elementary school teachers 

Lesson Objectives: 

1. Learn how to insert shapes 

2. Learn how to insert screenshots 

3. Learn how to insert online videos 

 

Time  Visual Aid/  Lesson Script 

Used  Whiteboard           
(I will share my 

computer screen 

throughout the class. 

 

I will also prepare a 

Word file to work on 

in the class for 

students.) 
 

0:00        
Today’s Goals 

1. Learn how to insert 

shapes 

2. Learn how to insert 

screenshots 

3. Learn how to insert 

online videos 

Introduction 

 

Before we start, you are all schoolteachers. You 

finished my Excel and Word classes so far, and it is 

time for you to do some more advanced topics. 

 

Good morning, students. 

 

Now, let’s do an exercise to check our knowledge. 

Use your computers and do the following: 

 

I will show you a Word document filled with text, 

so please make the same document. 

 

Please make sure you copy & paste your table from 

Excel. 
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Time  Visual aid/  Lesson Script    
Used  Whiteboard         

 
 

 

 

I’ll give you only 2 minutes. 

Please start…Time is up! 

 

Q: Mr. Newport, please show us your document! 

 

Do you have any questions about the last lesson? 

….Let’s continue .. 

 

So, today’s goals are… 

Please read No.1~3 for us! 

 

Please open the Word file I sent you already. 

 

0:05 
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Time  Visual aid/  Lesson Script    
Used  Whiteboard         

 

Insert Shapes 

 

- Insert Shapes 
Now, I’m going to show you how to insert shapes 

into a Word document. As always, follow me on 

your PC. 

 

1. Click in the document where you want to insert a 

shape. 

2. Click the Insert tab. 

3. Click the Shapes button. 

4. Select the shape that you want to insert and click 

Insert. (Rectangle) 

That’s all! Could you do it? Come to my PC and do 

it. (Circle) 

Let’s continue. 

  

0:15 

 
(Work on 

the already 

given file) 

Exercise 

 

Now, let’s do an exercise to check our 

knowledge. Use your computers and do the 

following: 

 

I will show you a Word document filled 

with text, so please insert a shape into the 

document. 

 

Please use the techniques that we just 

studied. 

 

I’ll give you only 3 minutes. Please 

start…Time is up! 
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Q: Mr. Newport, please show us your 

document! 

Time  Visual aid/  Lesson Script    

Used  Whiteboard         

0:20 

Insert Screenshot 

 

- Insert Screenshot 
Now, we are going to insert screenshot into a Word 

document. 

 

We can add a screenshot directly from Word into 

your document.  

It is useful when you want to create steps or 

procedures of doing something on a PC. 

 

Now, I’m going to insert a screenshot into a Word 

document. As always, follow me on your PC. 

 

1. Click in the document where you want to insert a 

shape. 

2. Click the Insert tab. 

3. Click the Screenshot button. 

4. Select Screen Clipping. 

5. Select the area that you want to clip. 

That’s all! Could you do it? Come to my PC and do 

it.  

Let’s continue. 
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Time  Visual aid/  Lesson Script    

Used  Whiteboard         

00:30 
(Work on 

the already 

given file) 

Exercise 

 

Now, let’s do an exercise to check our 

knowledge. Use your computers and do the 

following: 

 

I will show you a Word document filled 

with text so please insert a screenshot into 

the document. 

 

Please use the techniques that we just 

studied. 

 

I’ll give you only 3 minutes. Please 

start…Time is up! 

 

Q: Mr. Newport, please show us your 

document! 

 

0:35 

Insert online videos 

 

- Insert online videos 

Now, I’m going to show you how to insert online 

videos into a Word document.  

 

You can insert an online video into your document, 

from YouTube for example. 

 

By following this procedure, you can make the 

thumbnail appear on your document which is very 

easy to see. A thumbnail is a kind of short video 

memo of a video file that you want people to see. 

When you click on the thumbnail, the video file for 

it opens for the user to see the video content. 

 

As always, follow me on your PC. 



3/2022 

 

1. Copy the link of the video that you want to 

insert to your document. 

2. Click in the document where you want to insert 

an online video. 

3. Click the Insert tab. 

4. Click the Online Videos button. 

5. Paste the link for your video and press Insert. 

 

Now, this makes the thumbnail of the video appear 

on your document and you can play it on the 

document.  

 

That’s all! Could you do it? Come to my PC and do 

it. 

Let’s continue. 
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Time  Visual aid/  Lesson Script    

Used  Whiteboard         

 

 

 

0:40 

 
(Work on 

the already 

given file) 

Exercise 

 

Now, let’s do an exercise to check your 

knowledge. Use your computers and do the 

following: 

 

I will show you a Word document filled 

with text so please insert a screenshot into 

the document. 

 

Please use the techniques that we just 

studied. 

 

I’ll give you only 3 minutes. Please 

start…Time is up! 

 

Q: Mr. Newport, please show us your 

document! 
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Time  Visual aid/  Lesson Script    

Used  Whiteboard         

0:45 

Wrap up 

 

We have only 5 minutes left, so let’s warp up 

today’s lesson. 

 

Q: Mr. Newport, how do you insert a shape? 

Please show us!  

That is correct! (If correct)/ Are you sure? 

Can you help us Mr. Ota? (If Newport’s 

answer is incorrect) 

 

Q: Mr. Ota, how do you make and insert a 

screenshot? Please show us! 

That is correct! (If correct)/ Are you sure? 

Can you help us Mr. Ota? (If Newport’s 

answer is incorrect) 

 

Q: Mr. Newport, how do you insert an online 

video into your document? Please show us! 

That is correct! (If correct)/ Are you sure? 

Can you help us Mr. Ota? (If Newport’s 

answer is incorrect) 

 

That is all for today’s lesson. Do you have 

any questions? See you in my next class. 

 

 

0:50 
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Presentation Plan   
 

Presenter Name:      Topic: 

Presentation Target Time:     Presentation Date: 

Presentation Audience Level: 

 

 

Presentation Objectives: 

1. 

2. 

3. 

4. 

5. 

 

 

Time  Visual Aid/  Presentation Script 

Used  PowerPoint           
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Time  Visual aid/  Presentation Script    
Used  PowerPoint         
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Task 4-Read the orientation materials 

 

Purpose: The following orientation materials contain the basic information of what is expected of  

  you as a trainee, what you can expect from your instructors, how you will be judged  

  during your training and advice that will help you to survive and improve. Understanding 

  this information will help to avoid any misunderstandings about your training. 

 

 

What you need to do: You need to read the information before you arrive at the 

 training center. Your instructor will give you details in your 

 first technical English class. 
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Information about your technical classes 

 

Your training center instructor will give you an orientation about your technical classes in your first 

formal lesson. Below are some of the topics your instructor will go over with you: 

 

1) Who you are and what is expected from you 

2) What is expected from your instructors 

3) Choosing topics for your training 

4) How you will be judged 

5) Advice for if you have trouble 

6) Helpful ideas for you to be successful in your training 

 

The purpose for your orientation is to help you to understand what your English language technical 

training will demand of you. Details of the above topics will be made clear so that there will not be any 

misunderstanding about your technical class training. 

 

Feel free to ask your instructor if you have any questions about any of the above training topics. 
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Task 5 

Your First Assignment 

Part 1 

You are to give a minimum 3-minute speech in your first technical in English about your host country, 

your future workplace and what you will do there. You will need to gather as much information about it 

between now and your speech date (your JICA Data Sheet is a starting point).  

 

The purpose of this speech is to get you to think, act and speak more comfortably in English and to help 

you understand your future role as a computer engineer. You need to prepare for it as much as possible. 

 

After you have finished making your speech, each of your classmates will ask you one question in 

connection to what you have said. Those questions will be good English practice for them to ask and for 

you to answer. You might also guess what questions people will ask you so that you can prepare and 

practice answering them before your speech. 

 

Part 2 

In your second technical class, you must give the presentation you made for Task 3 of this webpage to 

your technical class in English. Your instructor and classmates will watch and give you feedback to help 

you improve your performance. 
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Appendix 1- Sample of “Can-Do List” in English 

 

 

 

 

 
 

 

Tasks 

Can 

1. Follow simple orientation instructions in preparation for job-related activities 

2. Make simple questions to get basic facts or more explanations 

3. Show someone the necessary actions for completing a job task using very simple language 

4. Say what is happening, what will happen, or what has happened while demonstrating a skill 

5. Describe how a mechanical, natural, or social system works in simple sequenced statements 

6. Give detailed instructions on how to do a job, or on how to use a principle or formula to solve a problem 

7. Give warnings and explain what will happen and why it will happen if we do or don’t do something 

8. Change the technical language of a theory, equation, or concept into more simple language 

9. State professional titles and explain personnel roles in profession or technical field 

10. Name common tools, materials, parts of equipment, etc. in job area and state their uses 

11. Read or listen to and understand books, articles, or lectures about the technical subject 

12. Name basic topics, concepts, equations, symbols, etc. in technical subject area 

13. Check audience’s knowledge and skills level and decide what they need to learn 

14. Make the objectives for a lesson, workshop, community projects, etc. to teach knowledge or skills 

15. Choose the necessary information and activities for teaching a lesson 

16. Make the questions or test tasks to check how much my audience have learned 

17. Prepare and give full lessons, workshops, or presentations by myself 

18. Make original plan and choose contents for a full technical information and skills course 

19. Write or present a project proposal or report 

20. Make an audience change their attitudes or habits or make them agree to cooperate 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Can-do items table for trainee self-evaluation 

Trainee’s Name:________________  Job: _______________ Date: ______________ 

T. Class Teacher: _________________________________ 
18 22 

23 
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Appendix 2- Peer and Self Evaluation Forms 

 

Presentation Evaluation Form 
 

Speaker: _______________________  Subject: _______________________  Date: ____________ 

 

Introduction      Poor  Minimum  Good  

Ability to catch the audience’s attention  ____  _____   _____ 

 

Lesson Body        P L M G E  

Main points are clear     __ __ __ __ __ 

Key vocabulary words written   __ __ __ __ __ 

Explanation of main points    __ __ __ __ __ 

Check for audience comprehension   __ __ __ __ __ 

Use of examples     __ __ __ __ __ 

Audience participation    __ __ __ __ __ 

Organization of lesson    __ __ __ __ __ 

 

 

Presentation of information    P L M G E  

Use of general vocabulary    __  __ __ __ __ 

Ability to answer audience questions   __ __ __ __ __ 

Time management     __ __ __ __ __ 

Preparation for this presentation   __ __ __ __ __ 

Eye contact with audience    __ __ __ __ __ 

Self-confidence of speaker    __ __ __ __ __ 

 

  

Conclusion      Poor   Minimum  Good 

Summary or conclusion was made   ____  _____   _____ 

Check of audience comprehension   ____  _____   _____ 

 

P = Poor performance  L = Lacking performance M = Minimum performance   

G = Good performance E = Excellent performance 

 

Your feelings about today’s presentation (Circle one) 

Excellent  Good  Fair  Difficult  Poor 

 

Your suggestions to improve the presentation  (Write them below) 
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Self- Evaluation Form 

Speaker: ___________________ Subject: ____________________ Date: ___________ 
 

A) How did you feel about your presentation? (Circle One): 

 

 Very good  Good  Fair  Not too bad  Bad 

 

B) What were the good points of the presentation? Please list them below: 

 

 

 

 

 

 

C) What were the bad points of the presentation? Please list them below: 

 

 

 

 

 

 

D) What changes would you make in the presentation to make it better? Please list them below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

25 


